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Toolkit SP-3 Features

Customer Service Toolkit Service Pack 3, commonly referred to as “Toolkit SP-3,” has several new or changed features:

· Support for multiple user file system encryption on laptops and desktops. The “Customer Files Toolkit” folder changed to “My Customer Files Toolkit” located in the user’s file system (see File System Encryption).
· The Toolkit eAuthentication Login Screen now includes standard eAuthentication features, such as Change My Password and Reset My Forgotten Password (see eAuthentication Login).
· A new option on the File menu allows users to delete unassigned customer folders, i.e., customer folders on the endpoint that are not currently associated with a record in the NCPDB (see Delete Unassigned Folders).

·  “Last Check In” date was added to Toolkit Check In/Out tab and Folders tab (see Last Check In, Open a Customer Folder).

· New Advanced Search capabilities in the Check In/Out tab, including searches by program or practice code, by planned and applied date, and/or by associated customer (see Advanced Search).
· The “Rename Folder” button on the Folders tab allows the user to rename the customer file on the service center server and in the National Conservation Planning Database (see Rename a Customer Folder).

· Assistance notes may be sorted by assistance date, assisted by, or program code within a given customer folder (see Sort Assistance Notes).
· State and County local programs are now supported (see Practice Schedule, Toolkit Preferences). 

· Users may hide applied and recurring practices in Practice Schedule (see Hide Applied and Recurring Practices).

· Extended Narrative ID’s for modified narratives in Practice Schedule (see Extended Narrative ID).
· A new option is available in the Plan Wizard to not limit the practice acres to the total acres of the land unit (see Customize the Plan).

· The contract support forms in the Contract Wizard are based on the new NRCS-CPA-1155 and 1156 forms (see Contract Wizard Forms).

· Copy/Paste during digitizing now makes inclusions (see Common Tools on All Digitizing Toolbars).
· New center pivot irrigation digitizing tool (see Center Pivot Tool).
· Circle digitizing tool allows user to specify the radius in Toolkit Toolbar (see Practice Polygons Editor).
· Ability to set user preferences on Map Products map generation (see Map Products Tool).
· Soils Map tool has options to generate the map and/or the report (see Soils Map/Inventory Tool).
· Auto Save Symbology for a map document (see Save Symbology).


Each of the novel features listed above is described in this document.  For documentation on all Toolkit SP-3 features, see Toolkit Online Help for SP-3, available at:  http://cst.nrcs.usda.gov/Toolkit/Help/.

File System Encryption
With Toolkit SP-3, customer folders and files that are encrypted to protect data can be checked in/out and used by the Toolkit user.
Customer data needs to be protected by Toolkit users as per guidelines related to the Privacy Act. ITS will perform the encryption of a workstation’s file system according to their schedule for encrypting specified folders and files. Toolkit SP-3 can be installed before or after the workstation’s file system is encrypted. Installing Toolkit SP-3 does not encrypt the workstation’s file system.
Toolkit SP-3 supports Microsoft’s Encrypted Files System for multiple users on a single workstation. To use file system encryption, the location of the check in/out folder was changed from C:\Customer_Files_Toolkit to 
C:\Documents and Settings\<login.name>\My Customer Files Toolkit

Moving this folder to this new location allows Toolkit to:  (1) run under the user’s Windows login account and (2) access the folders and files encrypted for the logged in user. When a different user logs in to run Toolkit on the workstation, Toolkit will access folders and files for this logged in user under this individual’s “Documents and Settings” file system.  
Toolkit SP-3 users should take note that, to add documents or files to a Customer File, they will need to check out the customer folder with the Customer File, navigate to the new location for checked-out Customer Files (C:\Documents and Settings\<login.name>\My Customer Files Toolkit), add the desired documents, and then check the folder back in.
Resolving ArcGIS Map Document File References

The workstation folder for customer files C:\Customer_files_Toolkit was replaced by C:\Documents and Settings\<login.name>\My Customer Files Toolkit to support file system encryption for each user. The ArcGIS map document (.mxd) contains the pathname to referenced files. Toolkit SP-3 saves a text file called "Name.mxd_LayerList.txt" when a map document is saved or when exiting ArcGIS. This text file is used to resolve the pathname to the referenced files when another Toolkit user checks out the customer files and opens the map document.

eAuthentication Login
With Toolkit SP-3, standard eAuthentication features, such as Reset My Forgotten Password (shown on next page), are available when authenticating into Toolkit.

To start Toolkit, follow these instructions.

1. Select Start > All Programs > Customer Service Toolkit > Toolkit or click on the Toolkit icon on your desktop or QuickStart menu.

2. The first time you use Toolkit, and thereafter on a periodic basis, you will see the following message.  Click Yes to synchronize the domain data.
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3. If you are not authenticated, the eAuthentication window is displayed. 
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4. Enter your User ID and Password, then click Login.

5. If your login fails, consult the eAuthentication Help Desk for assistance, or use one of the features available in the gray block at right.

6. Wait for domain data to complete synchronizing before using Toolkit.

Delete Unassigned Folders

A new option on the File menu allows users to delete unassigned customer folders, i.e., customer folders on the endpoint that are not currently associated with a record in the NCPDB.
To delete a customer folder on a given endpoint that does not have any associated records in the NCPDB, following these instructions.  
1. Click on File > Delete Unassigned Folders.
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2. The Delete Unassigned Folder dialog window will appear.
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3. If desired, select a different county (for example, Hardin).
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Note:  You may search for specific folders.  In the following screen, we show the results of a search for folders containing the name, “Brown.”  One folder containing the name, “Brown,” was found on this endpoint.
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4. To view the unassigned folders for a given endpoint, click on the [image: image9.png]


 icon located in front of the server name. 
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5. The Unassigned Folders List will expand to show all the folders that are not associated with an existing record in the NCPDB.
[image: image11.png]Delete Unassigned Folder

[~ Search for unassigned flders

County: [HARDIN |
(Unassined Folders Lt

Find [ e |

ikervertdatatCustomer Fies Traiing Hardin 15 HARDIN
55 0] WTkserver\data\Customer iles TookisHardin 2 HAFDIN
] \blen_Mason-——~DEMOS
] \Barb_Brown-——DEMO4
JBeth_Alian-——DEMO3
I \BrettAdems-——DEMD2

Delete Selected Folders





6. Select one or more folders that you wish to delete from the endpoint.  

In this example, we will be deleting the folder named, “Brett Adams-------DEMO2” from the endpoint for Hardin county. This folder is not associated with any existing customer records in the NCPDB and it has been determined that this customer data will not be needed in the future.

7. Check the box in front of “Brett Adams-------DEMO2.”
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8. Click on Delete Selected Folders. 
9. The following informational message will appear.  If you wish to proceed, click OK.
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10. The list of folders in the Unassigned Folders List block will refresh and confirms that the selected folder has been deleted from its endpoint. 
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Check In/Out Tab

Last Check In

With Toolkit SP-3, the Last Check In date is visible in the customer folders list (located under the heading, ‘National Conservation Planning Database’ on the left-hand side of the Check In/Out Tab).  This date is updated each time the customer folder is checked in.
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Search the NCPDB for Specific Customer Folders

The Check In/Out tab has a number of search features.  With regular search, you may filter the customer folders that are displayed in the “National Conservation Planning Database” frame at left for the selected county by:  (1) customer or business name, (2) business identifier, and/or (3) tract number.
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Note:  See Advanced Search for instructions on performing multi-parameter searches using Associated Customer, Programs, Practices, Planned Date, Applied Date, and/or Customer Name.

Perform a Search

1. Type in the desired criteria (e.g., enter “Robert” in the Customer or Business Name field.

2. Click Go.

3. Wait for the search results to be displayed in the left-hand pane.  

Only folders in the selected county that meet the specific search criteria will be listed in the left-hand frame.  If you need to search for folders in a different county that what is shown in the County field, use the drop-down list to select a new county.  

Note:  If you need to access folders in other counties, please contact your Toolkit Coordinator for assistance.

Customer or Business Name Search

When searching on the name of a customer or producer, you may enter all or part of a name in the Customer of Business Name field. Entering “Robert” in the Customer or Business Name field will bring back a list of all folders in that county that contain “Robert” in either the Customer or Business Name or the Customer Folder Name.  

Toolkit Tip:  If you cannot remember the exact Customer or Business Name, you can look on the local server to see the Customer Folders that exist at a given endpoint.  If you remember the approximate date that you last worked on this customer folder, you can sort the folders on the local server by date. If the folder is only in the legacy folder (F:\Customer Files) and not in F:\Customer Files Toolkit folder, then you may not have checked in the folder using Check In Wizard.  

Business ID Search

When performing a search using the Business ID, you may enter all or part of the Business ID.  For example, a search on the string “CSP” in the Business ID will return all customer folders for that county whose Business ID contains “CSP.”  

Refresh the NCPDB List

To refresh the NCPDB list at left so that it displays all the customer folders for that county, remove all text in the customer or business name, business identifier, and/or tract number text boxes, then click GO.

Advanced Search

In Toolkit SP-3, an Advanced Search button was added to the Check In/Out tab.

Use Search the NCPDB to filter the customer folders by (1) county, (2) customer or business name, (3) business identifier, and/or (4) tract number.

[image: image17.png]Customer Service Toolkit - DEVELOPER_TESTING 05.02.02.035'

&0

Search the National Conservation Planning Database for your sevice area

County:  [DICKINGON =] customerorBusiness Neme: [ Gear| | 60|





1. To perform an advanced search, click on the Advanced Search button near the top right of the Check In/Out tab.  
2. The Advanced Search window will appear. 
3. Enter the desired search criteria in the Associated Customer, Programs, Practices, Planned Date, Applied Date, and/or Customer Name blocks of the Advanced Search dialog window.  For example, the following screen illustrates a search for all folders in Dickinson county that contain EQIP plans with a Planned Date of October 2006.
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Search by Associated Customer Only

In the Advanced Search window, you may uncheck the option Include Programs, Practices, and Dates in Query to limit the search to the Associated Customer.  As an example, the next screen illustrates and example search for all customer folders in Dickinson county for a customer named, "Public".
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Note that the Programs, Practices, Planned Date, and Applied Date selectors are disabled.  Also, the parameters used for this search are displayed in the Current Query block.
Folders Tab

Open a Customer Folder

In Toolkit SP-3, the date of the Last Check In is provided on the Folders tab, along Status, Owner, County, Customer Name, Business ID, and Customer File.  The Last Check In column is located after the Owner column. This date is updated each time the customer folder is checked in.
You may select and work with only one folder at a time in Toolkit.  Follow these steps to open a customer folder in Toolkit.

1. Click the Folders tab.
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2. Select a folder by clicking in the left-hand, gray column to highlight the row.  Folders with a read-write status [image: image21.png]wite:



 can be edited. Folders with a read status [image: image22.png]& read



 can be viewed only.

3. Click the Open Folder icon.
You also may open a folder by double-clicking the row.

4. The General tab is displayed. 

Rename a Customer Folder

With Toolkit SP-3, a new feature is available on the Folders Tab that allows users to rename the customer folder.

The Rename Customer Folder feature allows you to rename the Customer/Business Name, the Business ID, or both.  The customer folder needs to be checked out before the feature can be used to change the name of the customer file.  

Note:  You must have Toolkit All permissions to rename a folder. If you need this feature and currently do not have this option on the Folders tab, contact your Toolkit Coordinator.  User permissions are maintained by state coordinators.
To access this feature, go to the Folders tab.  

1. On the Folders tabs, highlight the customer that you wish to rename.

2. Click on the Rename Customer Folder button.[image: image23.png]



3. The following window will appear.
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You may rename the Company/Business name, the Identify, or both.

4. Enter the new Company/Business name (if you wish to change it).  Avoid using the special characters identified on the Rename Customer Folder screen.
5. Enter the new business ID in the Identifier field (if you wish to change it).

6. Click OK.
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7. Toolkit will change the name of (1) the customer folder on the NCPDB, and (2) the Customer File on your local server.

Note:  The Business ID must be unique within each county.  Toolkit will provide a warning notifying you to enter a different Business ID if the Business ID you typed in is already in use for that county. 

Rename a Plan

SP-3 has a new feature for renaming plans in a checked out folder.
The Rename Plan feature allows you to rename a plan in a specific customer folder.  The customer folder needs to be checked out before the feature can be used to change the name of the customer file. 

Note:  You must have Toolkit All permissions to rename a plan. If you need this feature and currently do not have this option on the Folders tab, contact your Toolkit Coordinator.  User permissions are maintained by state coordinators.
To access this feature, go to the Folders tab.  

1. On the Folders tabs, highlight the customer that you wish to rename.

2. Click on the Rename Plan(s) button.[image: image26.png]



3. The following window will appear.
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4. Select the Plan from the Plan Name drop-down list.  If only one plan resides in this customer folder, the name of this plan will be automatically entered for you.

5. Enter the new name for this plan in the New Plan Name field.
8. Click OK if you wish to proceed.
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9. Click Cancel to exit without applying the change.
General Tab

The General Tab has been changed for SP-3.  The new design points out that the contact information for a given customer comes from SCIMS. 
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Note:  Any information in the SCIMS Customer Information block that is missing, inaccurate, or out of date on will need to be corrected in SCIMS.  SCIMS data on the General tab cannot be updated by the Toolkit Team.  

Sort Assistance Notes
SP-3 has new sorting capabilities for assistance notes.
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To sort assistance notes within a given customer folder, simply click on the heading of the column you wish to sort by.  The next screen shot show the result of sorting the assistance notes (shown in the above screen shot) by the Assistance Date. Notice that an arrow appears to the right of the column heading to indicate that the notes are being sorted by that data field.
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Practice Schedule
In Toolkit SP-3, the Practice Schedule has a new feature which allows you to hide applied and/or recurring practices.

In order to select the Practice Schedule tab, you must first have a customer folder checked out and open (for help see check out or open a folder).

1. Click on the Practice Schedule tab.

2. To add a practice to the schedule from the All Practices area in the top right corner of the Practice Schedule tab, choose the practice(s) you wish to add.
· You may select more than one practice by holding down the Ctrl key and clicking on each practice you wish to add, or you may choose a group of practices by holding down the Shift key and clicking on the first and then last row you wish to select.

3. The selected practices will be highlighted.

4. Press the Schedule Practices button to add the practices to the Practice Schedule.

5. The newly added practices appear in the schedule in the lower half of the Practice Schedule window.

6. Once you have added the practices to the schedule, complete the Narrative, Planned Amount, Month, and Year columns in the table.  

7. Completing the Applied Amount, Applied Date, and Program information in the schedule is optional.

8. Once you are finished making changes to the practice schedule, click Save.

You may exit the Practice Schedule by clicking on another customer tab or closing the folder, or you may develop a plan or contract document using the Plan Wizard or Contract Wizard.
Note:  If the Plan or Contract Wizard buttons are grayed out, turn off the Hide Applied Practices and/or Hide Recurring Practices features to activate these buttons.  

Hide Applied or Recurring Practices
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The above screen shot shows two new options that are available on the Practice Schedule tab:  
· Hide Applied Practices
· Hide Recurring Practices. 
You may check one or both check boxes, depending on what practices you wish to hide (if any).  The default settings when you open Toolkit, open a customer folder, and then navigate to the Practice Schedule, are for the hide applied and hide recurring practices options to be unchecked (as shown in the above screen shot). The options you check will remain active until you uncheck them, or until you close and then restart Toolkit.  
Note:  Selecting the Hide Recurring Practices or Hide Applied Practices option disables the Plan and Contract Wizard buttons.  To activate these buttons, uncheck the checkboxes for the hide practices options.  

Hide Applied Practices
In the following example, we show the Schedule block before and after hiding the recurring practices. 
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Before.  The above screen shot shows the Schedule block, with all practices displayed. This screen shows that, as before, practices that have been reported as applied are grayed out and cannot be edited.
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After.  The above screen shot shows what happens to the displayed practices after selecting the Hide Applied Practices option.  Notice that none of the rows are grayed in this example.
Hide Recurring Practices
In the following example, we show the Schedule block before and after hiding the recurring practices. 
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Before.  The above screen shot shows the Schedule block, with all practices displayed. This screen shows that, as before, practices that have been reported as applied are grayed out and cannot be edited.
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After.  The above screen shot shows what happens to the displayed practices after selecting the Hide Recurring Practices option.  Note that only the first occurrence of a recurring practice is displayed and the entire row is highlighted in gray to indicate that the other instances are hidden.
Extended Narrative ID

With SP-3, you have a new capability for customizing narratives:  You may create an Extended Narrative ID for a narrative you have modified via the Practice Schedule. 

To create a custom narrative:

1. Type in the desired suffix in the white text box labeled, 'extension,' located just to the right of the ID field in the Custom Narrative block. 
- The narrative ID can only be extended a maximum of 5 characters.  

2. Modify the narrative text as desired.

3. Click OK.

Browse for Text

You may enter a narrative from an existing .txt file.  To use this feature, click the Browse for text button near the top right corner of the Custom Narrative block.  It is important to note that this feature replaces the narrative text with the text contained in the selected .txt file (which means that the narrative text contained in the .txt file is not appended to the narrative text displayed in the lower half of the Custom Narrative block). If you would like to add an existing narrative, follow these steps:

1. Copy and paste the existing narrative into a new .txt file (e.g., using Notepad).

2. Modify the custom narrative as desired.

3. Use the Browse for text feature to enter the entire description into the Custom Narrative Block.

4. Click OK.
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Customize the Plan

With Toolkit SP-3, an option is available in the Plan Wizard to not limit the practice acres to the total acres of the land unit.
The Set Preferences dialog box of the Conservation Plan Wizard allows you to customize the conservation plan.  For example, the items in the plan may be sorted by Land Use or by Practice.  The following options are set by default:

· Display the Practice Narrative

· Display Participant Signature Box(es)

· Display Applied Practices 

Follow these instructions to set your desired preferences for the plan that you are building.

1. In the Check Option block, remove a check mark to any option you wish to remove from the plan document. 

· By default, all options are turned on (i.e., checked). 

2. In the Total Practice Acres block, the default option is to limit the land unit acres to the acres for that land unit.  
· If desired, you may click the Radio button labeled, Do not limit to land unit acres.

· This calculation for total acres only appears in the plan.xls document.
3. Select the method by which practices are sorted on the plan document. 

· Sorting by Land Use, the default, groups information on the plan by land use, practice, tract, and land unit number. 

· Sorting by Practice, groups information by practice, tract, and land unit number. This method displays the practice code on the plan.

4. Select How to print Recurring Practices.

· By default recurring practices are displayed on the plan for each year they occur.

· If you wish to consolidate the practices and only display them for the first year (followed by an R to indicate that it is a recurring practice), select Consolidate recurring practices to first year.  Mark with 'R.'

5. If more than one Field Office and/or Conservation District have been set up (check your settings in Toolkit Preferences), you may change the office or district by using the drop-down list in the Signature Box area.

· By default the Signature Box area displays the Field Office, the Designated Conservationist Name and Title, as well as the Conservation District.  

6. Enter a Standard Statements that you wish to use on the plan (optional).  

· You may save standard statements to use on multiple plans by creating them with a text editor (MS Word, Note Pad, etc) and saving them as text files (with a .txt extension) in the default directory C:\Program Files\USDA\Toolkit5\Templates\PlanWizard.

7. To insert an existing statement, click on the Browse button to the right of the Standard Statements area and click Open.

· The statement is displayed in the Standard Statements box.

· As needed, edit the statement.

8. Enter any desired text in the Plan Objectives field (optional). 

· If plan objectives are entered, a box titled Objective(s) appears at the top of the plan displaying the text.

9. To produce the plan document, click Finish.

· Wait for the plan to be displayed in Excel.

· As needed, adjust page breaks. Select View in the Excel menu and select Page Break Preview. 

· The page breaks appear as dashed blue lines. 

· Use the mouse to click and drag page breaks to the desired location.

· Page breaks that have been moved appear as solid blue lines.

10. At this point you have the option of printing the plan or saving the plan.

Contract Wizard Forms

With Toolkit SP-3, the most recent version of the contract forms (NRCS-CPA-1155 and NRCS-CPA-1156) approved by the OMB in 2006, are available.

With Toolkit, you can develop, customize, and revise conservation documents including plans, contracts (NRCS-CPA-1155) and contract revisions (NRCS-CPA-1156).  Creating plans and contracts with Toolkit involves five steps: 

· Add or edit land unit information

· Schedule practices

· Develop plans and contracts with wizards

· Customize plans and contracts

· Print the documents

The Contract Wizard guides you through creating a contract support document NRCS-CPA-1155 or a contract revision document NRCS-CPA-1156. To develop a contract, complete the following steps: 

· Select a contract template.

· Select a cost list.

· Develop or revise contract items.

· Select participants for signature blocks. 

Select Guide from a Nearby State
With Toolkit SP-3, you may now select a guide from a different state.
When first selecting your Guide in the Practice Schedule, you have the option to include guides from another state.  
1. To use this option, check the include nearby county guides option.
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2. The Select surrounding area county dialog box will appear.
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3. Select the state (and county) from which you wish to obtain guides, and then click OK.

4. Select Yes to include the unique guides from the selected state (and county). Note: selecting a county in the current state will not provide additional unique guides for the CRA.
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ArcGIS

Common Tools on All Digitizing Toolbars

With Toolkit SP-3, copy and paste to the land unit layer now creates an inclusion in the land unit.

Several tools are common to all digitizing toolbars, regardless of the type of layer you are editing.  These common tools include the:

Editor [image: image41.png]Edtor >



 - use to display the following menu options:

· Start Editing - for turning on an edit session.

· Stop Editing - for ending an edit session.

· Save Edits - for saving edits periodically during the edit session.

· Use vertical topology - use to ensure topology rules between layers.  If turned on, it prevents overlapping features between layers. If turned off, the topology rules are not enforced. 

· Snapping - used to set snapping parameters for the target layer.

· Undo Edit [image: image42.png]


 - use to undo the last vertex or last completed feature.

· Redo Edit [image: image43.png]


 - use to redo the last undo action.

· Copy and Paste[image: image44.png]B @



 - use to copy features from one layer and paste them into another layer.

Land Unit Editor Digitizing Toolbar
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The Land Unit Editor includes the following tools, in addition to the common tools described above:

· Select Feature [image: image46.png]


 - use to select features in the layer, prior to using other tools, such as split or merge.

· Add Field Tool [image: image47.png]


 - use to add fields, append fields and add inclusions to the planned land units layer.

· Split Field Tool [image: image48.png]


 - use to split an existing field.

· Merge Tool [image: image49.png]


 - use to merge two or more fields together.

· Topology Editor [image: image50.png]


 - use to select a common boundary before using reshape or vertex tools.

· Reshape Tool [image: image51.png]


 - use to reshape an existing field boundary.

· Vertex Edit Tool [image: image52.png]


 - use to edit vertices of an existing field.

· Circle Tool [image: image53.png]


 - use to add circles to the layer. Press 'R' on the keyboard to specify the radius while digitizing.
· Center Pivot Tool [image: image54.png]Center Pivot



 - use to cut out center pivot shape.

Center Pivot Digitizing Toolbar

New functionality has been added to the Land Unit Editor Toolbar in Toolkit SP-3.  The new tool is invoked by clicking on “Center Pivot” on the Land Unit Editor Toolbar.  

Center Pivot Tool

Instructions for using the center pivot tool are provided below.  You will need to be in your map document, with your conservation plan open in order to use the center pivot tool.
To invoke the center pivot tool, start an edit session on a land unit layer.  

· On the editor toolbar (at far right), you will see the Center Pivot menu which opens the Center Pivot toolbar (below).

[image: image55.png]



Click on Center Pivot to open the Center Pivot Toolbar.
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Center Pivot Toolbar

The following five functions are available via the Center Pivot Toolbar (from left to right):

· Circle Template Graphic

· Graphic Selection Tool
· Select Features Tool
· Center Pivot Tool
· Center Pivot Help
Center Pivot Graphic Template (Optional) [image: image57.png]



This template may be used if you do not have an imagery file to trace an existing center pivot.  Also use this tool when you wish to create a perfect circle with a specified radius.

Specify Radius

To invoke the user specified radius option, select this tool and follow these instructions.

1. Click on the map. 
2. Simultaneously hold down the left mouse button and press the ‘R’ key on your keyboard.  

3. The following dialog box will pop up:
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4. Enter in the value, e.g., “500”, and press Enter.
The radius is always entered in feet.
5. The Graphic Template will appear on the map.
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The magenta circle shown above is the result of using the Center Pivot Graphic Template Tool.

Graphic Selection Tool [image: image60.png]


  

Because the Center Pivot Graphic Template tool is a graphic, it can be moved around rather easily by using the Graphic Selection Tool on the Center Pivot Toolbar.  With this tool, you have the ability to move and resize the graphic to fit into an existing field.

Feature Selection Tool [image: image61.png]



One of the requirements in order to create a Center Pivot shape is for there to be an existing exterior field from which the Center Pivot can be cut out.  (In order to select the field that is going to contain the Center Pivot shape, we have added the feature selection tool to select the field.)

You need to use this selection tool in order to activate the Center Pivot Tool button.

Note:  The polygon that will contain the center pivot will need to be digitized prior to using this tool.  Notice that in the following screen shot, the pre-existing exterior field is selected and the template is turned off.
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Center Pivot Tool [image: image63.png]


  

Once you have the exterior field that will contain the center pivot shape selected the tool will become activated.

The instructions for creating a center pivot irrigation system are as follows:

1. To activate the Center Pivot Tool, the existing field that will contain the center pivot irrigation system must be selected. 
2. The first click starts the sketch; the second click will begin the arc of the side of the center pivot shape.  The third click finishes the arc. Continue this process until you create the full center pivot shape.  Double-clicking on your original starting point will finish the center pivot shape.  

3. The result is essentially a circle.  

We provide an example below to illustrate the procedure.

Example:  Creating a Center Pivot Irrigation System

The first click is at the top of the circle; the second click is to the left along the graphic template.
[image: image64.png]



When dragging the mouse toward the third click, notice how the arc is forming.  In the following view, ortho is turned off to illustrate this more clearly.
Notice that the pivot point is displayed in the center of the circle.
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Continue around the whole center pivot shape.  To see the outcome: 

· Delete the graphic by using the Graphic selection tool.
· Right-click and select delete (as shown below).  DO NOT PRESS THE DELETE KEY. 
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Alternatively, you may move the graphic aside to view the result. 
Below is an example of a finished result.  At the end of the procedure you will have 5 land units:  the center pivot shape and 4 corner land units.
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If the procedure worked successfully, a new field is created where the Center Pivot Tool snaps to the exterior field. Notice the new field at upper right in the example shown below.
[image: image68.png]




Note: The number of fields that are created with this tool depends on where you snapped on the polygon selected in Step 2. In the above example, there were four snaps, so there are four new shapes plus the center pivot shape.
Undo and Redo

If for some reason, you do not get the expected result (after your double click), simply do an undo and try again.  If the center pivot digitizer cursor does not appear when you are digitizing in a straight line, right-click and press delete sketch to get the digitizer back to normal. The following screen shot provides an example an undesired result; you will notice that two corner fields are missing.
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Center Pivot Help [image: image70.png]



The last icon on the Center Pivot Toolkit is a help icon.  Clicking on this icon brings up the online documentation for the Center Pivot Irrigation Tool.
Practice Polygons Editor

With Toolkit SP-3, depress 'R' on the keyboard to specify the radius while digitizing.  This feature is available when creating any circle in SP-3.
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In addition to Editor, copy/paste, undo, and redo, the following tools are included in the Practices Polygons Editor toolbar:

· Select Feature [image: image72.png]


 - use to select features in the layer, prior to using other tools, such as split, merge or reshape.

· Add Polygon tool [image: image73.png]


- use to add polygons, append polygons, and add inclusions to the practice polygon layer.

· Split Polygon tool [image: image74.png]


- use to split an existing polygon.

· Reshape tool [image: image75.png]


- use to reshape an existing polygon boundary.

· Vertex Edit tool [image: image76.png]


- use to edit vertices of an existing polygon.

· Circle tool [image: image77.png]


- use to draw circles in the layer.  

Map Products Tool

With Toolkit SP-3, a new feature provides the ability to set user preferences on Map Products map generation.

Use the Map Products tool to create a map with a heading, legend, scale, and North arrow. This tool is always active.

General information that you type in the choice lists in the Map Products dialog box is saved in: C:\Documents and Settings\<login>\Local Settings\Application Data\USDA\Toolkit5.  The information saved includes Map Title, Agency, District, Field Office and Assisted By values,  The next time you open the Map Products tool, the previous settings are available in the choice lists on the dialog box. The values entered for Approximate Acres, Date and Legal Description are not saved. 
Create a Map Product

1. Click the Map Products icon [image: image78.png]


to open the Map Products dialog box.
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- The View changes to a Layout View.
- The map is displayed behind the Map Products dialog window.
- Add a check mark to each item you wish to include in the map header (e.g. Assisted By). 
- Text may be added to any dialog box/choice list by typing in a blank box.
- To remove an item from a dialog box/choice list, highlight the item and press the Delete key.

2. For Map Title, select a title from the drop-down list or enter a title in the dialog box.  
The value in the Customer Name field may not be changed.

3. Select the Field Office from the drop-down list or enter in a field office name in the dialog box. 

4. Select the Agency from the drop-down list or enter in the agency name in the dialog box. 

5. Select the Conservation District from the drop-down list or enter in the district name in the dialog box. 

6. To include a list of Land Units in the header, add a check mark to the Land Units check box.

7. Select a name from the Assisted By choice list or enter a name.

8. To include a Date, enter a date in the date dialog box.

9. To include Approximate Acres, enter an amount in the dialog box.

10. To include a Legal Description, enter the description in the dialog box.

11. Click Apply to refresh the header settings in the layout.

Save Preferences

You may also save the settings you entered in the Map Products screen to use at a later time. After performing steps 1-10 (above), click the Save Preferences button.
[image: image80.png]Tool

Information

d) ep prodcspreorences sved




Use Preferences

To use preferences you have saved previously, click the Use Preferences button.
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Soils Map/Inventory Tool

In Toolkit SP-3, the Soils Map / Inventory tool has options to generate the map and/or the report.  You will see the new check boxes near the center of the Soils Map and Inventory dialog window. 
The Soils Map/Inventory tool [image: image82.png]


on the Toolkit toolbar works only when a soils theme and a land unit layer are added to the view.  You can use the Soils Map/Inventory tool to: 

· Produce a customized soils map and legend for the customer.

· View an inventory of soils for a specific field(s).

To create a Soils Map layer for all the land units in the land unit layer, clear any selected features in the land unit layer. You may use the Clear Selected Features icon to clear a selection.

1. Click the Soils Map icon [image: image83.png]


.
The Soils Map and Inventory dialog box is displayed.
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2. To create a Soil Map theme for only a few land units in the land units theme, first select the land units from the theme with the ArcGIS Select Feature icon [image: image85.png]


. 

3. Then click the Soils Map icon [image: image86.png]


.

4. Select Land Unit Layer from the Selected Layer drop-down list.

5. Select Soils Layer from the drop-down list.

6. Accept the Layer Name, Soils Map, or enter another name. 

7. Accept the default file name or click the Browse to enter another file name. 
Do not change the path of the new layer.

8. In the Soils Inventory Report Display options, check the boxes for any items you wish to include in the soils report, including the Customer Information. 

9. To summarize by Tract and Land Unit Numbers, check the check box. 

10. Click OK. 
The Soils Map layer is added to the view at the top of the table of contents.  
A soils report is displayed on top of the View window.

11. You may print and/or save the soils report by clicking on the File menu.  
Use the standard Windows Print/Save functionality.

12. To close the soils report click on the X in the top right corner of the document. 

Save Symbology

With Toolkit SP-3, a new auto-save feature has been implemented for saving symbology.  

Previous to Toolkit SP-3, the user would need to complete the following steps to save a legend for the current map document.
1. From the table of contents, right-click on the layer.

2. Select Save Symbology.

Using Toolkit SP-3, the symbology is automatically saved when the user clicks on Save, Save As or Exits a map document in ArcGIS.
State and Local Options
In SP-3, State and County local programs are supported in Practice Schedule and Toolkit Preferences. 

Toolkit Preferences allows each user to customize the Toolkit application with their own unique preferences.  To change your Toolkit Preferences, complete the following steps.  

1. From your Windows desktop, select Start > All Programs > Customer Service Toolkit > Toolkit Preferences. 

2. You can also access Toolkit Preferences, by clicking the Wrench icon [image: image87.png]


on the Toolkit Toolbar.

3. You can also access Toolkit from the Toolkit menu bar by selecting Tools > Toolkit Preferences.

4. If prompted, click Yes to synchronize with the National Planning Conservation Database.  

5. If you are not authenticated, the eAuthentication window is displayed.  
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6. Enter your eAuthentication User ID and Password, then click Login.

7. The Toolkit Preference window is displayed with six tabs.  Step-by-step instructions are provided for each tab.  In addition, each tab has a Save button that is used to save your changes as well as a Cancel button to undo your changes (i.e., to retain your original settings).  The six Toolkit Preferences tabs include:

8. Choice Lists for NRCS and/or Local Land Use selections and the associated program. 

If desired, Toolkit Preferences can be set up on one workstation and copied to another (see Copy Toolkit Preferences).

How to Obtain Help

Technical Support Options

If you encounter a problem with Toolkit, a number of information resources are available to you, including online help, user documentation, and technical support.

Online Help

Toolkit Online Help is available at all times, regardless of whether you are running Toolkit.  In Internet Explorer, simply go to the following URL:

· http://cst.nrcs.usda.gov/Toolkit/Help/.

Alternatively, you may access Online Help by clicking on the Help in the Toolkit SP-3 main menu.            

Hundreds of help topics are included in Toolkit Online Help, which features an easy-to-browse index and an excellent search tool.  Simply type in a keyword or phrase in the Search field (and depress Enter) to generate a list of Toolkit help pages related to that topic.  To navigate to Help page, click on a topic title.   

For detailed instructions on how to search for specific information in Online Help, see the Search Toolkit Help section.
Toolkit Web Site

For the latest information on Toolkit, visit the Toolkit Web site at:

· http://www.itc.nrcs.usda.gov/toolkit.  

In addition to Frequently Asked Questions, training resources, deployment information, and an online troubleshooting guide, the Toolkit user guides are available for download from the Training and Support page.

Technical Support

Additional support is available through the ITC Help Desk and Toolkit Support.  Help desk support is available weekdays from 6 AM to 6 PM Mountain Standard Time.  

	ITS Help Desk

	Phone
	888-311-1444

	Web Site
	https://merlin.sc.egov.usda.gov/magicsshd/


	Toolkit Support

	Email
	toolkitsupport@ftc.usda.gov


Document the Problem

You can assist the support team in resolving your problem expediently by gathering some basic information about the issue you encounter.  

First, document the steps or actions you performed just prior to the error.  Include the following information:

Second, when possible:  

Capture the error or warning message by simultaneously pressing the Ctrl and Print Screen buttons on the keyboard (to copy the message), then paste the screen shot into a blank MS Word document.

Email the document to Toolkit Support, along with the following information:

· Your user name

· Your contact information (including phone and extension)

· The best time to reach you

· The level of urgency

· Names of customer folders that are affected, if applicable
· For installation and configuration issues, provide the machine name

· A screen shot or description of the error you experienced

· Actions you were doing when the error was obtained

 eAuthentication Problems

If you cannot log into Toolkit, try logging into my.NRCS if you are an employee.  If you are an Affiliate, go to the USDA eAuthentication Web site, www.eauth.egov.usda.gov and click on "Update Your Account."  If you are unable to log in successfully to one of these sites, the problem is related to your eAuthentication Level 2 account.  If this is the case, contact the eAuth Help Desk for assistance.
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USDA eAuthentication is the system used by USDA agencies to enable customers to obtain
coounts that will allow them to access USDA Web applications and services via the Internet. This
includes things such as submitting forms electranically, completing surveys online, and checking
the status of your USDA accounts.

Please note that USDA will only accept eAuthentication Accounts from individuals

Currently USDA eAuthentication daes nat have the mechanism to issue accounts to businesses,
corporations or other entities

To apply for a USDA sAuthentication Account, pleass visit the Create An Account Page.

To find more information about the new eAuthentication Fargatten Password and Forgotten User
ID Process, please visit the Frequently Asked Questions page.
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